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File Menu

New...
Open...
Close
Summary Info...
Extension List...
Distribute...
Delete
Exit



Group Menu

Rename...
Remove
New
Add Resources...
Empty Wastebasket



Resource Menu

Distribute
Compress
Open
Remove



View Menu

Name
All Details
Partial Details...
All Resources
Resources with Conflicts
Sort by Name
Sort by Path
Sort by Type
Sort by Size
Sort by Reference Date



Options Menu

Toolbar
Status Bar
Minimize on Use
Save Settings on Exit



Window Menu

Cascade
Tile Horizontally
Tile Vertically
Arrange Icons
Refresh
Split



Help Menu

Index
Using Help
About Resource Manager...



New Command

Allows you to create a new resource file.



Open... Command

Allows you to open an existing resource file.



Close Command

Allows you to close the current resource file.



Summary Info... Command

Displays a dialog box in which you can enter summary information about the resource file (such as title 
and author) and a password.

Related Topic:
Using the Summary Info Dialog Box



Extension List... Command

Displays the available filename extensions for each group. You can change the associated file extensions 
or create new ones.

Related Topic:
Using the Extension List Dialog Box



Distribute... Command

Allows you to set the source and target distribution information and create distribution disks.

Related Topic:
Using the Distribute Dialog Box



Delete Command

Allows you to delete the current resource file.



Recent Filename Command

Displays the name of the most recently used resource file. Choose this option to open the file.



Recent Filename Command

Displays the name of the second most recently used resource file. Choose this option to open the file.



Recent Filename Command

Displays the name of the third most recently used resource file. Choose this option to open the file.



Recent Filename Command

Displays the name of the fourth most recently used resource file. Choose this option to open the file.



Exit Command Command

Allows you to exit the Resource Manager.



Rename... Command

Allows you to rename a group in the resource file.

Related Topic:
Using the Group Rename Dialog Box



Remove Command

Allows you to remove a group from the resource file.



New Command

Allows you to add a new group to the resource file.



Add Resources... Command

Allows you to add resources to an existing resource file.

Related Topic:
Using the Add Resources Dialog Box



Empty Wastebasket Command

Allows you to permanently remove a file reference from a resource file.

Related Topic:
Removing Resources



Distribute Command

Allows you to mark and unmark files for distribution.

Related Topic:
Marking Resources



Compress Command

Allows you to mark and unmark files for compression during distribution.

Related Topic:
Marking Resources



Open Command

Allows you to open (run) a file displayed in the Resources area.



Remove Command

Allows you to remove a file reference from a resource file.



Name Command

Allows you to show filenames only.



All Details Command

Allows you to show all resource information.



Partial Details... Command

Allows you to show partial information by setting options in the Partial Details dialog box.

Related Topic:
Using the Partial Details Dialog Box



All Resources Command

Allows you to show details for all resources.



Resources with Conflicts Command

Allows you to show details for only the resources that are in conflict.



Sort by Name Command

Allows you to sort by filename.



Sort by Path Command

Allows you to sort by pathname.



Sort by Type Command

Allows you to sort by file type (extension).



Sort by Size Command

Allows you to sort by file size (from largest to smallest).



Sort by Reference Date Command

Allows you to sort by run date (from most to least recent).



Toolbar Command

Allows you to hide the toolbar, which is displayed by default.



Status Bar Command

Allows you to hide the status bar, which is displayed by default.



Minimize on Use Command

When this option is toggled on and you double-click on a file to launch it, the Resource Manager is 
minimized.



Save Settings on Exit Command

When this option is toggled on and you exit the Resource Manager, settings that describe the condition of 
the program (such as the size of the window) are remembered the next time you restart the program.



Cascade Command

Causes the currently open resource files to overlap so that each title bar is visible.



Tile Horizontally Command

Horizontally rearranges the currently open windows so that all are visible in the work area.



Tile Vertically Command

Vertically rearranges the currently open windows so that all are visible in the work area.



Arrange Icons Command

Evenly arranges the icons in the Resource area.



Refresh Command

Refreshes the view in the Resource area.



Split Command

Allows you to change the relative sizes of the Group area and Resource area within the active Resource 
file window.



Index Command

Displays all the Help topics that are available.



Using Help Command

Displays a short tutorial and other information about using online Help.



About Resource Manager... Command

Displays Resource Manager copyright and version information.



Registering Resources

Registering resources means 1) creating a resource file (if it does not already exist) and 2) recording 
resource descriptions within the resource file. You can register resources for an application at any time, 
but typically you do it when you have completed the application and are ready to distribute it.

To create a resource file you first ensure that the Register Resources option is turned on in IconAuthor. 
You then run the application within IconAuthor. As the application runs and accesses different files, those 
files are automatically added to the resource file. It is possible that you may not exercise every branch of 
the application. If a file is not accessed when you run the application, it is not automatically added to the 
resource file. The Resource Manager also lets you manually add any missed files to the application's 
resource file.

Related Topics:
Registering Resources within IconAuthor
Adding Resources within the Resource Manager



Resource File

A resource file describes the resources (files) that are used by an application.    It lists key information 
such as the name, size and last run date of each file. The resource file has the same name as the 
application file, except that it uses an .IAM extension. For example, an application called ABC.IWM, would
have a resource file called ABC.IAM. When the Resource Manager creates a resource file, it is stored in 
the same directory as the application file with which it is associated.



Registering Resources from within IconAuthor

By default, IconAuthor registers resources for a main application when it is run. IconAuthor recognizes a 
file that has an .IWM extension as a main application.

To register resources for a main application using IconAuthor:

1. Ensure that the Register Resources option is turned on.
When you are working with a main application, this option is on by default. To confirm that it is on, click
on the Resources button in the ribbon bar. If Register Resources is selected, the pop-up menu shows 
a check mark next to that option.
Note: You can also choose the Properties... command from the File menu to display the Register 
Resources option.

2. Run the application.
If you are running the application for the first time, a new resource file is created. If the application 
already has a resource file, the existing file is used. Each time a file is accessed during the run 
process, it is added to the resource file. The resource file is stored in the same directory as the 
application file with which it is associated.

You can also create a resource file and register resources for sub-applications. To do this, toggle on the 
Register Resources option and run the application as described above.    To change a main application 
into a sub-application or vice versa, click on the Resources button and choose File Type... When the File 
Type dialog box appears, select the appropriate option, Main Application or Sub-application.



Adding Resources

The Resource Manager lets you add resources to an existing resource file. This is useful in situations 
where running the application did not access every file that you want to distribute. For example, you may 
not have exercised every branch of the application or you may want to distribute a documentation file with
the application.

There are two ways to add resources. You can add resources in the conventional manner, so that the file 
or files are placed in groups according to their extensions. Or, you can select a specific group and place 
one or more resources there, regardless of the extensions associated with the group.

Related Topics:
Adding Resources by File Type
Adding Resources to a Group
Changing Resources



Adding Resources According to Filename Extensions

To add resources according to filename extensions:

1. Choose Add Resources... from the Group menu or click on the Add Resources... button in the tool bar.
The Add Resources dialog box appears. The dialog box varies slightly depending on how many groups
are currently selected. Specifically, if only one group is selected when you open this dialog box, the 
"Add files to selected group" option appears in the lower left corner. This option is explained below. 
Also, if one group is selected, the file filter reflects the extensions assigned to that group. If multiple 
groups are selected the file filter changes to *.*.

2. Change to the appropriate directory and find the file or files that you want to add to the resource file.
3. Select the desired file(s).

To select a single file, click on it. To select a range of files, click on the first file in the range, press and 
hold the SHIFT key and click on the last file in the range. To select multiple, non-contiguous files press 
and hold the CTRL key and click on the desired files.

4. If the "Add files to selected group" option is present (because only one group is selected), click on it to 
turn it off.
This ensures that files are added to groups according to their filename extensions.

5. Choose OK to close the dialog box.
The selected files are added to the appropriate groups in the resource file.



Adding Resources to a Group

To add resources to a group regardless of filename extensions:

1. Select the desired group.
2. Choose Add Resources... from the Group menu or click on the Add Resources... button in the tool bar.

The Add Resources dialog box appears.
3. Change to the appropriate directory and use the List Files of Type drop-down list to find the file or files 

that you want to add to the resource file.
4. Select the desired file(s).

To select a single file, click on it. To select a range of files, click on the first file in the range, press and 
hold the SHIFT key and click on the last file in the range. To select multiple, non-contiguous files press 
and hold the CTRL key and click on the desired files.

5. Leave the "Add files to selected group" check box turned on.
This ensures that files are all added to the selected group. This is true even if the filename extensions 
are not normally associated with the selected group.

6. Choose OK to close the dialog box.
The selected files are added to the selected group.



Groups
The information in a resource file is organized by groups. The default groups are named similarly to the 
default sub-directories used by IconAuthor. For example, there is a Graphic group (for graphic resources) 
and a Text group (for text resources).



Viewing Resources

Each resource file that is open is contained in its own window. Each resource file window is divided into a 
Group area and a Resource area. 

Group area - By default, the Group area shows the 15 possible groups (including the Wastebasket) where
resources can be positioned. These groups are tools that let you organize and view resources. They are 
arbitrary groups that do not precisely correspond to directories and do not control the physical location of 
a resource. For example, you can move a resource from one group to another, but this does not move the
file physically. Rather, it moves the reference to the file.

Resources area - By default, the Resources area is empty. When you select one or more groups in the 
Group area, the Resources area displays the list of all of the resources in those groups. For example, if 
you select a group that has two files, those files are displayed in the Resources area.

To view the files that belong to a group:

+ Select the group(s).
To select a single group, click on it. To select a range of groups, click on the first group in the range, 
press and hold the SHIFT key, and click on the last group in the range. To select multiple, non-
contiguous groups press and hold the CTRL key and click on the desired group. Any files within the 
group are displayed in the Resources area.

Related Topics:
Resource Area Information
Group Area Information



Resource Area Information

The Resource Area displays the following kinds of information.

Filename
Path
File Size
Last Run Date
Distribute
Compress

You can use options in the View menu to change how this information appears.



Filename
In some cases, the filename is preceded by a lined versus a blank file symbol. This is the same 
convention that is used by the Windows File Manager to show that a file isassociated with a (Windows) 
executable (.EXE) program. As in the File Manager when you double-click on one of these associated 
files in the Resource Manager you launch the associated program and open the file. For example, double-
clicking on an associated SmartObject file (in the Resource Manager or the Windows File Manager) will 
launch the SmartObject Editor and open the file. (Use the Windows File Manager to associate a Windows
executable with a file type. For more information, see the description of the Associate... command in the 
Microsoft Windows User's Guide.)

Also, when the Resource Manager cannot find a file, it displays a "?" in the file symbol (and in place of the
file size). The file may have been moved or removed from the specified path.



Path
This indicates the physical location of the file. The path description is not related to the Resource 
Manager group in which the file description is listed. For example, a file can be physically located in a 
directory called PROJ1 but be positioned in the Animation group.



File Size
This is the file size before compression. If the file cannot be located, a "?" appears in place of the file size.



Last Run Date
This shows the last occasion on which this file was accessed. If you are preparing to distribute your 
application and find files with very old run dates, you may want to make sure that these files are still being
used by your application. If you add files to the resource file manually, the last run date fields will be 
empty and appear as follows: __/__/__.



Distribute
This symbol appears when a file is marked for distribution.



Compress
This symbol appears when a file is marked for compression during distribution.



Group Area Information

When you register resources by running an application in IconAuthor, accessed files are added to specific
Resource Manager groups according to their extension. Files without an extension and files that have an 
extension that is not assigned to a specific group are placed in the Inbox.

Two additional groups, Present and Setup, are used to optionally distribute Present and customized 
Setup programs. The Resource Manager also lets you customize the selection of groups that appear in 
the Group area and the file extensions that correspond to each group.

Related Topics:
Removing Groups
Renaming Groups
Adding New Groups
Changing the File Extensions Associated with a Group
Adding or deleting an Extension Association



Changing Resources

When you open a resource file in the Resource Manager, you can change the information in the following 
basic ways:

Add resources to the file manually
Move resources from one group to another
Copy resources from one file to another
Remove resources from a file



Moving Resources to another Group

You can move a file from one group to another.

To move a file to another group:

1. Select the group (or groups) where the file (or files) is currently listed.
2. Click on a file to select it (or select a number of files).
3. Drag the selected item(s) to another group.

Moving a resource does not affect the physical location of the file. It simply moves the reference to the 
file.



Copying Resources to another Resource File

You can copy a file from one resource file to another.

To copy a resource to another file:

1. Make sure that the two resource files are open and visible within the Resource Manager.
2. Click on a file in the first resource file to select it (or select a number of files).
3. Drag the selected item(s) to a group in the second resource file.

Copying a resource does not affect the physical location of the file. It simply copies the reference to the 
file.



Removing Resources

You can remove a file reference from a resource file. For example, you may be reviewing a resource file 
and find reference to an old file no longer used by the application.

To remove a file reference from a resource file:

1. Select the file(s) you want to remove.
2. Drag the selected item(s) to the Wastebasket at the bottom of the Group area. (Or click the right 

mouse button in the Resources area and choose Remove from the pop-up menu.)
A message appears asking you to confirm the removal of the selected file(s).

3. Choose Yes to remove the file(s) or No to cancel the action.

The files are placed in the Wastebasket. They are not yet permanently removed from the resource file 
until you either empty the wastebasket (by choosing Empty Wastebasket from the Group menu) or quit 
the program by exiting the Resource Manager.

Note that removing a resource does not affect the physical location of the file. It simply removes the 
reference to the file.



Distributing Resources

Once you have registered the necessary resources in a resource file, you are ready to distribute your 
application by performing the following tasks.

Mark resources for distribution and compression.
Set the directories in which the application will be installed on the end-user system.
Resolve any file conflicts that may jeopardize the distribution process.
Copy the resources onto one or more distribution disks.



Marking Resources

Before you begin the distribution process, make sure that all of the appropriate files are marked for 
distribution and compression. 

By default, most files are marked for compression and distribution when they are registered within the 
resource file. You can mark and unmark files as desired. For example, you may choose to turn off the 
Distribute marker for certain files to omit them from a particular version of your application.

Although most files are marked by default, there are several important exceptions. Some files, such 
as .JPG and .RLE graphic files are not marked for compression by default. This is because these formats 
are already compressed. Similarly, some files, such as .BAT, .COM, .EXE, and .PIF files are not marked 
for distribution by default. This is because these files may not be appropriate for distribution. For example,
.EXE files are typically copyrighted and must not be distributed without legal permission.

To mark and unmark files:

1. Click on the file you want to affect.
You can also select a range of files by clicking on the first file in the range and pressing and holding the
SHIFT key while clicking on the last file in the range. Or, you can select multiple, non-contiguous files 
by pressing and holding the CTRL key and clicking on files.

2. Click on the Distribute and Compress buttons to turn these options on and off for the selected file(s).

Note: You can also use the Resource menu Distribute and Compress commands to mark and unmark 
files.



Setting the End-User Root and Target Directories

After the appropriate files are marked for distribution, you are ready to set the target directory (or 
directories) in which the application will be installed on the end-user system.

To set the target directories:

1. Choose Distribute... from the File menu.
The Distribute dialog box appears. You use the Target Directory area on the right to specify where you 
want the files to be placed when they are installed on the end-user system.

2. Click on the Root... button.
The Target Root Directory dialog box appears.

3. In the Name text box, type the target root directory. 
The target root directory is the top-most directory in which your application will be installed. Do not 
specify a drive or a slash, just a directory. You may not know the precise name of the target root 
directory. If you specify a root directory that does not exist on the target system, the Setup program will
create the root directory or allow the user to specify an alternative root directory.

4. Choose OK in the Target Root Directory dialog box.
At this point, the dialog box specifies that all files be installed in the root directory. Unless this is your 
goal, you need to refine this information so that it also specifies which sub-directories to use.

5. Select an item to indicate that you want to refine its specific target path information.
6. Click on the Target... button.

The Target Directory dialog box appears.
7. In the Subdirectory text box, type the name of the subdirectory (or subdirectory path) where you to 

install files that are being gathered from this specific source.
As an example, you can type \TEXT or \GAMES\TEXT.

8. Choose OK to close the Target Directory dialog box.
9. Repeat the process of selecting items in the Distribute dialog box to refine the sub-directory 

information as necessary.
10.When are finished specifying target paths, you can click Close to close the dialog box or you can 

perform the next distribution task which is to resolve any file conflicts (if any exist).

Hints for setting Target Subdirectories
Use the following techniques to set Target Directory information:

+ You can change the Target Root directory at anytime (even after you have begun setting Target Sub-
directories). When you re-set the Target Root directory it is always changed globally.

+ You can set a Target Subdirectory for multiple items, simultaneously. Before clicking on the Target... 
button, select multiple items in the Distribute dialog box. The path you refine in the Target Subdirectory
dialog box will be applied to all the selected items.

+ There is a shortcut in the Target Subdirectory dialog box. If you have already entered a path for a 
previous item, that item appears in the Target Subdirectory drop-down list. 



Resolving Conflicts

A conflict can occur if your application has two or more files with the same name and you specify that they
should be distributed to the same target directory. After you set target directories, use the Resource 
Manager to test for conflicts before you attempt to distribute your application. 

To test for conflicts:

1. Choose Distribute... from the File menu.
The Distribute dialog box appears. It contains the Source and Target directory information as you 
defined it. In most situations, the Conflicts... button is enabled and ready for you to begin the test. The 
only case when the Conflicts... button is not enabled is when all of an application's resources are 
located in one directory. (If all the files are in one directory, there cannot be multiple files with the same
name.)

2. Click on the Conflicts... button.
If there are no conflicts, the Resource Manager displays a message box to that effect. You can close 
the message box and continue with the distribution process. If there are conflicts, the Resource 
Manager displays the conflicting file references in a Conflicts dialog box that appears similar to the 
following.

3. Click on OK to close the Conflicts dialog box.
4. Click on Close to close the Distribute dialog box.
5. Select all groups to re-display the files in the Resource area.

The files are still marked for distribution but the Distribute symbol has changed to reflect the conflicts (it
now contains a "?"). The changed symbols serve to remind you of the specific conflicts that need to be
resolved. If your application uses a large number of files, you may find it useful to view only the 
resource with conflicts in the Resource area. To do this, choose Resources with Conflicts from the 
View menu.

6. Resolve any conflicts.
The way you resolve conflicts varies depending on the reason for the conflict. For example, your 
application may require the files that conflict, but you need to rename them or distribute them to 
different directories. In another example, your application may not need a file that is causing a conflict. 
In this situation, you can remove the file reference from the resource file altogether.

Note: When you remove a file that is causing a conflict, the conflict is not actually resolved until you 
empty the Wastebasket or exit the Resource Manager.

After you resolve conflicts, it is recommended that you re-open the Distribute dialog box and click the 
Conflicts... button once again. This will allow you to confirm that you have resolved all conflicts 
successfully. You are then ready to continue with the distribution process.



Creating Distribution Disks

This section describes the default disk creation process which produces a disk or disks that contain the 
Setup program and the files that make up your application. Only the files that you mark for Distribution are
copied. Any files that you mark for Compression are compressed if possible. In order to create disks you 
must previously have set the end-user target directories and resolved any potential distribution conflicts. 

Optionally, you can include Present on the distribution disk(s). You also have the option of customizing the
Setup program or of using your own setup program. 

Related Topics:
Distributing Present
Customizing the Setup Program

To create disks:

1. Make sure you have the formatted disks to which you plan to copy the application.
2. Choose Distribute... from the File menu.

The Distribute dialog box appears. It contains the source and target directory as you previously defined
it. 

3. Click on the Copy... button.
The Copy dialog box appears.

4. Use the Destination Drive drop-down list to select the drive to which you want to copy files.
5. Use the Setup File options area to select where you want the Setup program (and its accompanying 

files) placed during the copy process.
"Setup files in Root Directory" - If you are distributing one main application, you can leave the default 
setting to put the Setup program files in the root directory.
"Setup files in Target Root Directory" - If you are distributing multiple applications on the same disk, 
you need to put each group of Setup program files in a separate target root directory. Multiple 
applications cannot share Setup programs because each Setup program varies depending on the 
corresponding main application.
"Setup files not copied" - In some situations, you may want to distribute files without a Setup program. 
For example, if you need to give your files to another member of the development team, you can use 
the Resource Manager to place them on disk (conveniently, seamlessly gathering the files from the 
various source directories). DO NOT COMPRESS the files if you are not distributing the Resource 
Manager Setup program. Only the Resource Manager can decompress them.

6. Optionally, turn on the Protect Copy from Edits option.
When this option is on, the application you are distributing cannot be edited in IconAuthor. It can only 
be run via Present

7. Make sure that a clean, formatted disk is in the drive to which you are copying and click on OK.
The copy process begins. If the files that make up the application do not fit on one disk, the Resource 
Manager prompts you for another disk.
The Resource Manager displays a message indicating when the copy process is complete.

8. Choose OK to remove the message box.
The copy process is complete.



Running Setup

The person installing an application simply runs Windows, places the first disk into the drive and runs the 
Setup program. The program displays a Welcome message.

When the user clicks Continue a dialog box appears which displays the target root directory that you, the 
author, specified. The user can use the default or enter an alternative path. When the user clicks 
Continue, the setup process occurs. The user is prompted to insert the next disk when necessary. Setup 
displays a message indicating when Setup is complete. 

Related Topic:
Customizing the Setup Program



Removing Groups

To remove a group:

1. Click on the group you want to remove to select it.
Note that although you can select multiple groups, you cannot remove multiple groups simultaneously.

2. Choose Remove from the Group menu.
A message box appears asking you to confirm your decision to remove the group.

3. Click Yes to continue or No to cancel the action.



Renaming Groups

To rename a group:

1. Click on the group you want to rename to select it.
Note that although you can select multiple groups, you cannot rename multiple groups simultaneously.

2. Choose Rename... from the Group menu.
The Rename Group dialog box appears.

3. Type the new group name and click OK.
The name of the group changes and the group is re-positioned (if necessary) to reflect its location 
alphabetically. Any filename extensions that were associated with the group under its former name, 
are still valid for the new group name.



Adding Groups

To add a group:

1. Choose New... from the Group menu.
The New Group dialog box appears.

2. Type the name of the new group and click OK.
The new group is added to the Group area in alphabetical order. By default, there are no file 
extensions associated with a new group. For information on associating file extensions with groups, 
see the next subsection.



Changing the File Extensions Associated with a Group

You can change the file extensions that are associated with a particular group.

To change an associated extension:

1. Choose Extensions... from the File menu.
The Extension List dialog box appears.

2. In the Extension/Group list box, select the extension you want to change.
3. From the Group drop-list, select the group with which you want to associate the selected extension.
4. Continue to change the extension/group associations as desired.
5. Click on Close to close the dialog box.



Adding and Deleting Extensions

To add a new extension:

1. Choose Extensions... from the File menu.
The Extension List dialog box appears.

2. Click on the New... button.
The New Extension dialog box appears.

3. Type the new extension in the Name text box.
Use up to three characters. Do not precede the characters with the "." symbol.

4. Click on OK.
The new extension is added to the Extension/Group list box in the Extension List dialog box. By 
default, the new extension is not associated with a group. 

To delete an extension:

1. Choose Extensions... from the File menu.
The Extension List dialog box appears.

2. Select the extension/group association you want to remove.
3. Click on Delete.

A message appears asking you to confirm your decision.
4. Click Yes to delete the selection or No to cancel the action.



Customizing the Setup Program

The Setup program uses a SmartObject file called SETUP.SMT. This file controls the basic displays that 
make up the Setup program. Authors who are familiar with the SmartObject Editor can edit this file to 
customize its basic appearance. 

If you do not customize the Setup program, by default, when you create distribution disks, the Resource 
Manager uses the generic copy of SETUP.SMT that comes with IconAuthor. It is located in the directory in
which you installed IconAuthor.

If you decide to customize the Setup program, you must:

1. Run the SmartObject Editor and open the generic copy of SETUP.SMT
2. Edit SETUP.SMT according to the information and rules described later in this document.
3. Save SETUP.SMT in a different directory.

This will avoid overwriting the original, generic copy of the file. 
4. When you use the Resource Manager to prepare for distribution of your application, add the 

customized version of SETUP.SMT to the Setup group. 
5. Ensure that the file SETUP.SMT is NOT marked for distribution.
6. Proceed with the conventional distribution tasks.

Related Topics:
About SETUP.SMT
Cosmetic Changes to SETUP.SMT
Functional Changes to SETUP.SMT



About SETUP.SMT

The file SETUP.SMT is in the directory in which you installed IconAuthor. It consists of the following five 
pages. 

"Variables" - The objects on this page are not part of the visual display during setup. The information on 
this page controls certain aspects of setup such as how the Setup program message boxes are labeled 
and whether the Setup program creates an icon and/or program group for the application.

"Welcome" - This page displays a Welcome message and allows the user to continue or exit.

"Directory" - This page allows the user to accept or change the directory in which the application will be 
installed.

"Status" - This page displays while installation occurs. It describes the current status of the installation 
process.

"Complete" - This page displays a message box that lets the user no when setup is complete.



Cosmetic Changes to SETUP.SMT

You can customize the appearance of SETUP.SMT in several ways.

Edit the pages
Edit Existing Objects
Add New Objects
Change Message Box Titles
Change Distribution Disk Names



Editing Pages

You can change the color of pages. DO NOT delete or rename any pages.



Editing Existing Objects

Although there are restrictions, you can change existing objects. You can edit information such as the text
in text objects, the labels in buttons, and the color of the pages. 

Do not make any edits that disrupt or disable functional portions of the Setup program. Specifically:

+ DO NOT delete objects that are essential to the Setup program. For example, do not delete a button 
that lets the user navigate through the application.

+ DO NOT make any changes (other than cosmetic ones) to objects that are essential to the Setup 
program. For example, you can change the label on a push button, but you must not change the 
ObjectName or Notify- properties of a push button.

+ DO NOT change the ObjectName property of an object. This would also disrupt or disable the setup 
application.

Here are some examples of the kinds of changes you can make:

+ Edit the text in the Welcome message, for example, specifying the name of your company or the name
of the application, or changing the font or text color.

+ Change the colors used by the objects.
+ Change the labels on the buttons, for example, changing "Exit Setup" to "Quit."
+ Change the color of the page.



Adding Objects

Although there are restrictions, you can add new objects. Specifically, you can add text objects and 
graphic objects by adhering to the following rules:

+ When you create a graphic object ALWAYS embed (versus link) the graphic file.
+ DO NOT add any objects that obscure existing objects that are essential to the Setup program. For 

example, do not create a live graphic object that covers a navigational button. The button will not be 
able to be selected at runtime.

+ DO NOT attempt to add objects to alter the functionality of the Setup program. You do not have the 
ability to change the structure that supports new objects.

+ If you want an object to appear on a page and remain in view when a subsequent page is displayed, 
set the object's DeleteProtected property to True. If you do not set the DeleteProtected property to 
False, by default, every time a new page displays, the previously displayed objects are deleted.

Here are some examples of the kinds of objects you can add:

Add a text object that displays the Company Name or Version information.
Add a graphic object that displays a background graphic or a company logo.



Changing the Message Box Titles

You can edit SETUP.SMT so that the Setup program uses a different title on its message boxes. By 
default, the message box title is the name of your application (minus the extension).

To change the message box titles:

1. Run the SmartObject Editor and open SETUP.SMT.
2. Display the page called "Variables."
3. In the Message Box Title text box, specify the title you want to use. 



Changing Distribution Disk Names

You can edit SETUP.SMT so that the Setup program uses a different set of names to refer to the 
distribution disks. By default, the Setup program refers to the disks by number. For example, when 
necessary, it asks the user to insert "Disk #2". If you specify disk names, Setup uses the new name (for 
example, "Please insert the Graphics disk").    Specify disk names by separating each name by a semi-
colon (Setup;Graphics;Audio).

To change the distribution disk names:

1. Run the SmartObject Editor and open SETUP.SMT.
2. Display the page called "Variables."
3. In the Disk Names text box, specify the names you want to use. 

Use a semi-colon (;) to separate the names from one another. For example, Setup;Graphics;Audio.



Functional Changes to SETUP.SMT

You can customize the functionality of SETUP.SMT in several ways. These edits all involve making 
changes to the page called "Variables."

Related Topics:
Creating an Application Icon
Setting Path Information During Setup



Creating an Application Icon

You can edit SETUP.SMT so that the Setup program creates an icon for the application being installed. 
Note that in order to have Setup create the icon, you must include the icon file on the distribution disk(s).

To instruct the Setup program to create an icon:

1. Run the SmartObject Editor and open SETUP.SMT.
2. Display the page called "Variables."

Specifically, you will be editing the Program Manager Info part of the page.
3. In the Group text box, specify the program group to which you want to add the icon. 

For example, if you type "Games" the icon will appear in the Games program group. If you specify a 
group that exists, the icon will be added to it. If you specify a group that does not exist, the group will 
be created.

4. In the Icon File text box, specify the icon file used to display the icon.
Be sure to specify the name of the icon file relative to the setup root directory. For example, if the icon 
file is in the setup root directory, you can just type abc.ico. If the icon file is in the iconware sub-
directory, type iconware\abc.ico. Do not include a drive name.

5. In the Description text box, specify the text label that you want to appear beneath the icon.
6. In the Command Line text box, specify the command string that will execute the application when a 

user double-clicks on the icon. For example, if the application is called cards.iwm, the Command Line 
text box would contain present.exe cards.iwm.

7. In the Working Directory text box, specify the starting directory relative to the setup directory.    If this 
text box is blank, the working directory is the directory where the application in installed.

The Setup program will create the icon as specified. When the user double-clicks on the icon, the 
application will run.



Setting Path Information During Setup

By default, the "Variables" page of SETUP.SMT directs the Setup program to update the paths of several 
different types of files. 

The Iconware/Path Extensions text box lists all the application and path file extensions that will have their 
paths updated during setup. The default setting is iw;iwm;iww;pth. Similarly, the SmartObject Extensions 
text box lists the SmartObject file extension (smt) that will have paths updated during setup. 

As necessary, you can add other extensions to these lists. Or, if you do not want the path information 
updated during setup, remove the appropriate extension(s) from a list.



Distributing Present

Optionally, the Resource Manager lets you distribute Present with your applications.

Important: In order to distribute Present, you must 1) have the Present software installed on your system 
and 2) only copy the software in accordance with your Present license agreement.

The two steps for preparing to distribute Present are:
Automatically Updating the WIN.INI
Adding Present Files to the Resource File



Automatically Updating the WIN.INI

Before you distribute Present, you must decide whether you need to direct the Setup program to 
automatically update IconAuthor information in the WIN.INI file. The WIN.INI contains the following 
sections:

[IconAuthor]
[IconAuthorAudio]
[IconAuthorMonitors]
[IconAuthorOverlay]
[IconAuthorPlayer]
[IconAuthorPorts]

The first section contains settings for the IconAuthor/Present BreakKey (the key that allows users to 
escape from the running application) and the IconAuthor/Present Version number. The remaining sections
contain settings for multimedia hardware accessories. 

By default, the Setup program does not automatically update information in the WIN.INI file. Optionally, 
you can direct the Setup program to perform the updates by editing the SETUP.SMT file. You need to 
decide whether it is necessary for Setup to update the WIN.INI file. There are two basic reasons to 
update. 

+ You need to update if you want to set a BreakKey and/or Version information.
+ You need to update if your application uses multimedia devices that require drivers. For example, if 

your application uses Video For Windows, the [IconAuthorOverlay] and [IconAuthorPlayers] sections 
need to include just the setting "Video for Windows=iamciavi.drv". Also, the [IconAuthorPorts] section 
needs to include the setting "Video for Windows=".

Note: Any driver that you reference in the WIN.INI update must also be distributed with your application 
(along with Present).

To automatically update the WIN.INI file during Setup:

1. Run the SmartObject Editor and open SETUP.SMT.
2. Display the page called "Variables."

Specifically, you will be editing the information in the lower right corner of the page.
3. Click in the "Update win.ini" check box to turn it on.
4. As necessary, edit the entries in the accompanying list box.

Remove any unnecessary sections and entries. Leave the sections and entries that are required by 
your application. For example, if your application does not use multimedia devices that require drivers,
but you want to set a BreakKey, delete all but the first [IconAuthor] section.



Adding Present Files to the Resource File

After you have decided whether to have Setup update the WIN.INI and made the necessary edits, you 
can prepare to distribute Present.

To distribute Present:

1. In the Resource Manager, open the resource file through which you want to distribute Present.
2. Click on the Present group.
3. Choose Add Resources... from the Group menu.

The Add Resources dialog box appears.
4. In the Add Resources dialog box, select the files that make up Present.
5. Choose OK.

The selected files are added to the Present group.
6. Make sure the Present group files are marked for distribution.



Using an Alternative Setup Program

Advanced authors can optionally use an alternative Setup program of their choosing. If you decide to do 
this, you can still use the Resource Manager to distribute your resources, but do not compress files. Only 
the Resource Manager    Setup program is able to de-compress these files.

The Resource Manager has a Resource List feature which lets you automatically generate an ASCII file 
that contains a list of all the resources described in a resource file. This list can be useful to an alternative 
setup program that requires the resource information.

To generate a Resource List:
1. Review the resources in the resource file to ensure that they are complete.
2. Set the Target directories to which you want to distribute the resources.
3. Check the resource file for conflicts.
4. Choose Distribute... from the File menu.
5. Click on the List... button.

A Save As dialog box appears.
6. In the File Name text box, specify the name of file in which you want to save the list. 

An example would be GAMELIST.TXT.
7. Choose OK.

The information in the resource file is copied to the file. The following figure shows an example of the 
contents of a Resource List file.

[Distribution List]
1=c:\iauthor\graphics\matching.rle a:\iauthor\graphics\matching.rle
2=c:\iauthor\text\match.smt a:\iauthor\text\match.smt
3=c:\iauthor\iconware\matching.iwm a:\iauthor\iconware\matching.iwm

The top of the file always contains the heading [Distribution List]. The Resource List has a separate line 
for each resource in the resource file. Each line describes the source and target directories for a file.



About Box

This dialog box displays Resource Manager copyright and version information.



Summary Info Dialog Box

This dialog box allows you to record descriptive information about the currently active resource file. You 
can assign a title, comments, and your name to the file as well as set a password. Use the Password... 
button to set a password.



Target Root Directory Dialog Box

This dialog box allows you to set the target directory (or directories) in which an application will be 
installed on the end-user system.

To use the Target Root Directory dialog box:
1. In the Name text box, type the target root directory. 

The target root directory is the top-most directory in which your application will be installed. Do not 
specify a drive or a slash, just a directory. You may not know the precise name of the target root 
directory. If you specify a root directory that does not exist on the target system, the Setup program will
create the root directory or allow the user to specify an alternative root directory.

2. Choose OK in the Target Root Directory dialog box.
At this point, the dialog box specifies that all files be installed in the root directory. Unless this is your 
goal, you need to refine this information so that it also specifies which sub-directories to use.



Conflicts Dialog Box

This dialog box displays detected conflicts that will affect the distribution process. A conflict occurs if your 
application has two or more files with the same name and you specify that they should be distributed to 
the same target directory. 

If conflicts are detected, click on OK to close the Conflicts dialog box and resolve the conflicts. The way 
you resolve conflicts varies depending on the reason for the conflict. For example, your application may 
require the files that conflict, but you need to rename them or distribute them to different directories. In 
another example, your application may not need a file that is causing a conflict. In this situation, you can 
remove the file reference from the resource file altogether.

Note: When you remove a file that is causing a conflict, the conflict is not actually resolved until you 
empty the Wastebasket or exit the Resource Manager.

After you resolve conflicts, it is recommended that you re-open the Distribute dialog box and click the 
Conflicts... button once again. This will allow you to confirm that you have resolved all conflicts 
successfully. You are then ready to continue with the distribution process.



Copy Dialog Box

This dialog box allows you to begin creating distribution disks.
+ Use the Destination Drive drop-down list to select the drive to which you want to copy files.
+ Use the Setup File options area to select where you want the Setup program (and its accompanying 

files) placed during the copy process.
"Setup files in Root Directory" - If you are distributing one main application, you can leave the default 
setting to put the Setup program files in the root directory.
"Setup files in Target Root Directory" - If you are distributing multiple applications on the same disk, 
you need to put each group of Setup program files in a separate target root directory. Multiple 
applications cannot share Setup programs because each Setup program varies depending on the 
corresponding main application.
"Setup files not copied" - In some situations, you may want to distribute files without a Setup program. 
For example, if you need to give your files to another member of the development team, you can use 
the Resource Manager to place them on disk (conveniently, seamlessly gathering the files from the 
various source directories). DO NOT COMPRESS the files if you are not distributing the Resource 
Manager Setup program. Only the Resource Manager can decompress them.

+ Optionally, turn on the Protect Copy from Edits option.
When this option is on, the application you are distributing cannot be edited in IconAuthor. It can only 
be run via Present

+ Make sure that a clean, formatted disk is in the drive to which you are copying and click on OK.
The copy process begins. If the files that make up the application do not fit on one disk, the Resource 
Manager prompts you for another disk. The Resource Manager displays a message indicating when 
the copy process is complete.



Distribute Dialog Box

This dialog box allows you to perform several different kinds of tasks to prepare to distribute an 
application.

Related Topics:
Setting the End-User Root and Target Directories
Resolving Conflicts
Creating Distribution Disks
Using an Alternative Setup Program



Extension List Dialog Box

Use this dialog box to change the file extensions that are associated with a particular group.

Related Topics:
Changing the File Extensions Associated with a Group
Adding and Deleting Extensions



File Open Dialog Box

This dialog box lets you open an existing Resource Manager (*.IAM) file.

To open a file:
1. Make sure the dialog box is looking in the right place for the file you want.

The current path appears below "Directories." Use the Drives drop-down list box to change to another 
drive and use the Directories list box to change to another directory. Double-click on a closed directory
folder to open it. When a folder is open the files in that directory (that match the filter in the File Name 
text box) appear below the File Name text box.    

2. When the dialog box is looking in the right directory change the value in the List Files of Type field, as 
necessary. (For example to show all files in the current directory, choose All (*.*) in the list box.)

3. When the correct file appears in the File Name list box, double-click on the filename.



New Group Dialog Box

This dialog box allows you to add a group to the active resource file.

+ Type the name of the new group and click OK.
The new group is added to the Group area in alphabetical order. By default, there are no file extensions 
associated with a new group. For information on associating file extensions with groups, see the next 
subsection.



New Extensions Dialog Box

This dialog box allows you to add a new extension to the Resource Manager.

To add a new extension:
1. Type the new extension in the Name text box.

Use up to three characters. Do not precede the characters with the "." symbol.
2. Click on OK.

The new extension is added to the Extension/Group list box in the Extension List dialog box. By default, 
the new extension is not associated with a group. 



Get Password Dialog Box

This dialog box allows you to set a password for a resource file. Without the password, another author 
cannot open the file.

1. Type the password into the New Password text box.
2. Type the same password into the Confirm Password text box.

The OK button is only enabled if you have typed the confirmation correctly.
3. Click OK to close the dialog box.



Set Password Dialog Box

This dialog appears if a password is required by the resource file you are attempting to open. Type the 
password in the text box and click OK.



Rename Group Dialog Box

This dialog box allows you to rename a group.

+ Type the new group name and click OK.
The name of the group changes and the group is re-positioned (if necessary) to reflect its location 
alphabetically. Any filename extensions that were associated with the group under its former name, are 
still valid for the new group name.



Partial Details Dialog Box

This dialog box allows you to customize the information that appears in the Resources area. Click on the 
appropriate check boxes to make selections and click on OK.



Target Directory Dialog Box

This dialog box allows you to specify the target directory (or directories) in which the application will be 
installed on the end-user system.

1. In the Subdirectory text box, type the name of the subdirectory (or subdirectory path) where you want 
to install files that are being gathered from this specific source.
As an example, you can type \TEXT or \GAMES\TEXT.
You can set a Target Subdirectory for multiple items, simultaneously. Before clicking on the Target... 
button, select multiple items in the Distribute dialog box. The path you refine in the Target Subdirectory
dialog box will be applied to all the selected items.
There is a shortcut in the Target Subdirectory dialog box. If you have already entered a path for a 
previous item, that item appears in the Target Subdirectory drop-down list. 

2. Choose OK to close the Target Directory dialog box.



List Dialog Box

This dialog box is intended for advanced authors who are using an alternative Setup program. Specify the
name of the file to which you want to save an ASCII file that contains a list of all the resources described 
in the active resource file. This list can be useful to an alternative setup program that requires the 
resource information.



Add Resources Dialog Box

This dialog box lets you add resources to an existing resource file. This is useful in situations where 
running the application did not access every file that you want to distribute. For example, you may not 
have exercised every branch of the application or you may want to distribute a documentation file with the
application.

There are two ways to add resources. You can add resources in the conventional manner, so that the file 
or files are placed in groups according to their extensions. Or, you can select a specific group and place 
one or more resources there, regardless of the extensions associated with the group.

Related Topics:
Adding Resources by File Type
Adding Resources to a Group
Changing Resources



New Dialog Box

This dialog box allows you to create new resource file.




